WA

Universit?
RRE A ﬁs‘ﬁiﬁeri WARREDOC.UNISTRAPG.IT
DOC ./ di Perugia

3th Digital Mapping Course
Tutorial: Water-Food Nexus

L’importanza del Water-Food Nexus in agricoltura e significativa per produrre cereali, frutta e ortaggi su larga
scala, con particolare riguardo per il riso, il principale alimento di piu della meta della popolazione mondiale.
Tuttavia, la disponibilita di risorse idriche & fondamentale per soddisfare la domanda di cibo mondiale attuale
e delle future generazioni. In questo tutorial I’utente impara a sviluppare una StoryMap tramite gli strumenti
di ArcGIS online e open data, a migliorare la visualizzazione delle feature, a creare un’applicazione per
confrontare mappe tematiche sul rapporto fra acqua e riso e infine a integrare informazioni sull’esperienza
gastronomica del riso in Italia tramite piattaforme social media.

Obiettivo #1: Crea due mappe da visualizzare:
A. World rice production (tonnellate)
B. World water availability

Fonti di dati:

e Food and Agriculture Organization of the United Nations (http://www.fao.org/faostat/en/#data/QC)
e Google Research Tables (https://research.google.com/tables)

Nota: Tutti i dati provengono dai portali sopra citati e sono stati rielaborati al solo scopo di migliorare la
qualita complessiva dei dati, facilitando la lettura dei contenuti per gli utenti, migliorando la visualizzazione
delle feature ed evitare ogni possibile problema relative all’uso di open data.

1. Innanzitutto vai su ArcGIS website e inserisci le tue credenziali.

Need an ArcGIS Public Account? @esri

An ArcGIS Public Account is a personal account with limited usage
and capabilities and is meant for non-commercial use only.

CREATE A PUBLIC ACCOUNT
¢ ‘ A

O Keep me signed in

SIGN IN

Forgot password? Forgot usemame?

OR

Sign in with | ENTERPRISE LOGIN
Sign in with n G
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2. Sul menu in alto
e Clicca su Map

Water Resources Research and Documentation Center

7 Edn

e Add > Search for Layers > ArcGIS Online > Cerca i seguenti file:
i. WARREDOC_World Rice Production and Water Availability (Poligoni)

Qg“ s Arctic
ca Ocean
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&~ ArcGIS Online »

Q Warredoc_World Rice

1 layers

=l = =

WARREDOC_World_Rice_Produ
ction_and_Water_Availability

9) by francisco.pena_wgis
Updated: 11/12/18

NORTH

3. Primadi iniziare a lavorare sulla mappa:

Click on the layer name > more options icon (tre punti) > Rename: World Rice Production
e Persalvare il progetto clicca su Save > Save as > Water-Food Nexus (Rice)

Bl Save v @@ Share = Print | @ Directions & Measure

Home v Water-Food Nexus (Rice) Z

4. Ora, apri la tabella degli attributi per controllare i dati e gli attributi selezionati di default sulla mappa.
Noi siamo interessati a realizzare una mappa tematica:

World Rice Production: (Poligoni)

e Nella lista viene incluso un totale di 109 Paesi. Noi siamo interessati ai dati piu recenti sulla
produzione di riso mondiale, organizzati nella colonna ‘Value’

e Change Style > Choose an attribute to show: Value
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e Select a drawing style > Counts and Amounts (Color) > Options > Classify Data using Natural
break with 5 classes > Set ranges 0, 100, 1000, 10M and 100M
e Change symbols > Scala di colori marrone > Transparency > 25% > OK

M World Rice Production

‘@VD

WARREDOC World Rice Production (Features: 109, Selected: 0)

Area_1

China

India

Indonesia

Element_Co Element

Item_Code

5,510

5,510

5,510

Production 27

Production

Production

27

27

Value

211,090,813

158,756,871

77,297,509

.......

5. La mappa tematica é pronta ma la quantita di produzione di riso manca ancora. Per rendere la mappa
comprensibile, aggiungi le etichette sul totale di produzione di riso sopra ogni Paese:

Label Features

Clicca sul nome del layer > more options icon (tre punti) > Create Labels > Activate Label
Features > Text: Value > Size: 12 > Style: Bold and Italic > OK
Clicca su Save per salvare tutte le modifiche

+
WARREDOC_World Rice Production B7E SWEDEN RUSS LA g
FINL A NIy et ]
L] HORWAY
v Label Features ‘:
Text: Value ‘O‘
2 -8l v il
L 164,700
. T D 181.075 43,635
LRG3 eazrs
Visible Range: 865812 227,540
e 920,000
World Room ~
59,35¢ 181,320 '
236
L 6,300,000
CANCEL . 0

6. Hai creato una mappa sulla produzione di riso mondiale. Ora, ripeti la stessa procedura per creare una
mappa sulla disponibilita di acqua per ogni Paese:

Disattiva il layer Water-Food Nexus (Rice)

Ripeti il passaggio, cerca un’altra volta il layer WARREDOC_World Rice Production and
Water Availability e cambia il nome ‘World Water Availability’

Per salvare la nuova mappa clicca su Save > Save as > Water-Food Nexus (Water)

Change Style > Choose an attribute to show: Annual_renewable_water_resource

Select a drawing style > Counts and Amounts (Color) > Options > Classify Data using Natural
break with 5 classes > Set ranges 0, 200, 500, 1000 and 2000

Change symbols > Scala di colore Blu > Transparency > 25% > OK

Clicca sul nome del layer > more options icon (tre punti) > Create Labels > Activate Label
Features > Text: Value > Size: 12 > Style: Bold and Italic > Activate Halo: 1, White > OK
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Obiettivo #2: Crea una Story Map Swipe
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ArcGIS Online consente agli utenti di confrontare mappe e layer simultaneamente in un’unica mappa

dinamica, migliorando la visualizzazione delle feature, dei valori su diversi livelli di scala e la

rappresentazione delle relative mappe coropletiche. In questo tutorial I’utente usera questa feature per

confrontare la produzione di riso e la disponibilita di acqua a livello globale.

7. Per creare una Story Map Swipe:

e Share > Share with everyone > Create a Web App > Compare Maps/Layers > Story Map Swipe

and Spyglass > Create Web App
e Title: Water-Food Nexus

e Tags and Summary: A discrezione dell’utente > DONE

Share Create a New Web App
P OU— p
Specify a title, tags, and a summary for the new web app

Title: Water-Food Nexus

o WARREDOC x

y: (Optional)
Lok to thie mep
hetps://arcg ia/ AHASTL o &

Embed tha map

8. Sullo schermo appare il Swipe/Spyglass Map builder:
e Swipe Style > Vertical bar > Next

e Swipe Type > Two web maps > Click on the magnifying glass > Select Water-Food Nexus (Rice)

e App Layout > Activate Description, Legend and Pop-Up > Next
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e Pop-Up > Left Map: World Water Availability > Right Map: World Rice Production > Open app

Water-Food Nexus n
:

STORY CONFIGURATION

Edit me!

13950
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9. Hai creato la Swipe Map App. Personalizza le impostazioni della Swipe Story Map come preferisci,
includendo tematizzazioni, logo, header e il pannello dei contenuti. Clicca su Save quando hai finito
e condividi pubblicamente (Share) il progetto per ottenere il link che userai per connettere la Swipe
App alla StoryMap finale.

Goal #3: Crea una Social Media App

Mentre I’integrazione di open data nelle mappe digitali ¢ il fondamento per le analisi spaziali e la location
intelligence per comprendere i processi naturali e antropici, il ruolo della citizen science attraverso i

contenuti dei social media allarga la nostra prospettiva sulla user experience tramite parole-chiave
selezionate.

Nota: Nel caso avessi per errore chiuso I’interfaccia della mappa ArcGIS Online, ti consigliamo di aprire una
nuova pagina sul tuo browser e ripetere il passaggio #1 per riprendere con il tutorial. Una volta che sei di
nuovo sull’interfaccia web della mappa clicca su New Map e seleziona Water-Food Nexus (Rice).

Details # Add ~ 7] Analysis ESave v ®® Share & t - @ Directions % Measure Y
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10. Per integrare contenuti dai social media sulla mappa:

e Share > Share with everyone > Create a Web App > Map Social Media > Public Information >
Create App
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o Title: Water-Energy Nexus Social Map
e Tags and Summary: A discrezione dell’utente > DONE

Create a New Web App
Create a New Web App

Title: Water-Food Nexus (Rice)

WARREDOC x

otw ‘
CREATE WEB APP

PREVIEW YOWNLOAD

11. Il pannello della web app appare sulla parte destra dello schermo, in cui ci sono tre riquadri:

e |l riquadro Legend visualizza il nome e i colori di ogni layer rappresentato sulla mappa

e |l riquadro About include il nome del progetto, la versione piu aggiornata e informazioni
aggiuntive.

e |l riquadro Layers € suddiviso in due parti. La prima include tutti gli shapefiles dalla mappa su
Water-Food Nexus Map e la seconda una lista di piattaforme di social media. Vai sulla barra di
ricerca e scrivi ‘Perugia’, poi attiva tutti i layer dei social media.

Configure: Water-Food Nexus (Rice)

Nota: Alcune piattaforme social media richiedono il login per visualizzare i contenuti

12. Vai sulle impostazioni e scrivi la parole-chiave ‘water’ nei layer di ogni social media.

Flickr Settings Twitter Settings YouTube Settings X
Return results matching a photo's title, description or tags. See what's happening right now. View user-generated videos including network and professional content
Search Terms Search Terms Search Terms

rice rice rice

Uploaded within the past Tip: use for creating advanced searches. Uploaded within the past

e ) [ Al Time -

All Time Twitter Account =

Switch account
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13. Clicca su Share per ottenere il link della mappa. Userai questo link per connettere la parte social media
nella StoryMap. La mappa dovrebbe apparire come questa:

Configure: Water-Food Nexus (Rice)

Layers
O World Water Availability

M World Rice Production

Media Layers

Show contributions from the public

on the map.

Instagram

Flickr

%]

%]

M Twitter
M Youlube
(]

Webcams.travel

Perugia

Twitter (1 of 3)

y

Share this map
Ay & =@

O Share current map exten

Riso @ Scampi crudi di Sicilia, tenue crema
di Caprino e bisque d'astice. Fried Rice with
Sicilian raw scampi, soft... https:/t.co

/t0CdSxfhzm

Map Link

hitps:

//arcg.is/0AGu1D

M8 Flickr (1 of 2)
0

toR! YouTube (1 of 3) » O
Firinda i¢ pilavl hindi- baked turkey
@ with seasonned rice- la dinde servie sur

du riz dans au four

Risotto al tartufo nero
12N0 KAGoldberg

Obiettivo #4: Crea una Story Map

La mappa realizzata é ricca di contenuti, comprensibile agli utenti e fornisce delle prime conclusioni:

e La Cina ¢ di gran lunga il pit grande produttore di riso al mondo ed ¢ al quarto posto per
disponibilita di acqua; in linea teorica il Paese é autosufficiente nel rifornimento di acqua a scopi

irrigui.

e La produzione di riso nei Paesi subsahariani e abbastanza elevata; tuttavia la disponibilita di
acqua € limitata e la mancanza di acqua nella regione potrebbe causare conseguenze devastanti
per ’agricoltura.

e La differenza di produzione di riso tra Paesi vicini si basa sulle proprie risorse idriche e
sull’economia. Mentre i valori elevati di disponibilita idrica e di produzione di riso possono
sembrare una generalizzazione, alcuni paesi non rispecchiano questo stereotipo. Per esempio la
Papua Nuova Guinea presenta valori moderati di disponibilita idrica (801) ma a malapena
produce riso (848 tonnellate), mentre 1’Indonesia si colloca tra i primi 10 produttori di riso
mondiale (77.297.509 tonnellate) seppur con risorse idriche limitate (69,70).

14. L’integrazione di piu strati di open data nelle mappe digitali puo essere arricchita da contenuti testuali
e visivi (immagini e video) che forniscono valore aggiunto al tuo lavoro in un contesto geospaziale.
Attraverso le Story Map puoi rispondere a questioni complesse e visualizzare nuovi trends e fenomeni
umani e naturali. Ora possiamo incorporare testo, contenuti social media e human experience alla tua
mappa. Per creare una Story Map:

Water Resource Research and Documentation Centre (WARREDOC)
Universita per Stranieri di Perugia - Piazza Fortebraccio 4, 06123 Perugia

+39.075.57461 - warredoc@unistrapg.it



mailto:warredoc@unistrapg.it

WA

Universit?
RRE pl%s‘iizgi‘eri WARREDOC.UNISTRAPG.IT
D 0 c dr rerugia

e Share > Everyone (public) > Create a Web App > Build a Story Map > Story Map Journal >
Create Web App > Title: Water-Energy Nexus > Compila Tags and Summary > DONE
e Scegli Pannello laterale

Create a New Web App
Share

Choose who can view this map.

Link to this map
https://arcg.is/1X4r04 Facebook Twitte

v! Share current map extent

Embed this map

N WEBSIT

Story Map Series Story Map Shortlist Story Map Swipe and
Spyalass

15. In base ai Termini e le Condizioni del 3° Corso di Digital Mapping, la Story Map deve essere
completata con i seguenti requisiti:

e Introduction (1 slide): Scegli un video dal web pertinente al tema della mappa e scrivi una breve
introduzione

e GIS section (1 slide): Crea 2 mappe per realizzare una web app di confronto tra acqua e cibo
(produzione di riso e disponibilita di acqua)

e Human experience (1 slide): Integra la user experience sulla tua mappa aggiungendo contenuti
dai social media (usando parole-chiave e hashtag) per ottenere informazioni utili sui
comportamenti umani

e Discussion and References (2 slide): Riporta i punti essenziali del tuo lavoro e i riferimenti
utilizzati (bibliografici, digitali, siti web)

Le seguenti figure illustrano i potenziali risultati della StoryMap:

- e ] e
T SUSTAINAELE P =
Water-Food Nexus S DEVELOPMENT s’ sction

|
SUSTA
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Water-Food Nexus Water-Food Nexus

. Conclusions
Rice as food

Water-Food Nexus

Bibliography

Guarda la Story Map completa: Water-Food Nexus

Congratulazioni!

Hai completato con successo il tutorial.

Water Resource Research and Documentation Centre (WARREDOC)
Universita per Stranieri di Perugia - Piazza Fortebraccio 4, 06123 Perugia
+39.075.57461 - warredoc@unistrapg.it



mailto:warredoc@unistrapg.it
https://arcg.is/qa1P9

